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About This Guide

IMPORTANT! Before using this product, read and understand the information in
Appendix D, “Safety” on page 85 in this document.

Revision history

Revision Date Description
B September 2012 Additional virtual bins added to the Yfiler®
allelic ladder bin set in Chapter 4, “"Analyze
Data”starting on page 25.
A July 2012 New document

Purpose

The AmpFI(STR® Yfiler® Direct PCR Amplification Kit User Guide (Pub. no. 4479446)
provides information about the Life Technologies instruments, chemistries, and
software associated with the AmpF(STR® Yfiler® Direct PCR Amplification Kit.
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Product overview

Purpose

Substrate
examples

Product
description

Overview

Product OVErvVIEW . . . ..ottt e 9
WOTKELOW . . o o 13
Instrument and software OVEerview . .............ouueiiineniineennneenn.. 14
Materials and equipment .......... ... ... 16

The AmpF(STR® Yfiler® Direct PCR Amplification Kit is a short tandem repeat (STR)
multiplex assay optimized to allow direct amplification of single-source samples:

Blood samples collected on treated paper or untreated paper substrates without
the need for sample purification.

Buccal samples collected on treated or untreated paper substrates without the
need for sample purification.

The loci amplified by the kit are:

European minimal haplotype: DYS19, DYS385a/b, DYS3891/11, DYS390, DYS391,
DYS392, DYS393.

Scientific Working Group on DNA Analysis Methods (SWGDAM)-recommended
Y-STR panel: European minimal haplotype, DYS438 and DYS439.

Additional highly polymorphic loci: DYS437, DYS448, DYS456, DYS458, DYS635
(Y GATA C4), and Y GATA H4.

Treated paper: COPAN® NUCLEIC-CARD"™ system or Whatman FTA® cards
Untreated paper: 903 paper, Bode Buccal DNA Collector ™

The Yfiler® Direct Kit contains all the necessary reagents for the direct amplification of
human male-specific genomic DNA.

The reagents are designed for use with the following Life Technologies instruments:

Applied Biosystems® 3100/3100-Avant Genetic Analyzer

Applied Biosystems® 3130/3130x! Genetic Analyzer

Applied Biosystems® 3500/3500x! Genetic Analyzer

GeneAmp® PCR System 9700 with the Silver 96-Well Block

GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
Veriti® 96-Well Thermal Cycler

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide 9



1 Overview
Product overview

About the primers

Loci amplified by
the kit

10

Non-nucleotide linkers are used in primer synthesis for the DYS438 and DYS456 loci.
For these primers, non-nucleotide linkers are placed between the primers and the
fluorescent dye during oligonucleotide synthesis (Butler, 2005, Grossman et al. 1994,
and Baron et al., 1996). Non-nucleotide linkers enable reproducible positioning of the
alleles to facilitate interlocus spacing. The combination of a five-dye fluorescent system
and the inclusion of non-nucleotide linkers allows for simultaneous amplification and
efficient separation of the 17 Y-STR loci during automated DNA fragment analysis.

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR® Yfiler® Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF/STR® DNA Control 007 are also listed in the table.

Table 1 Yfiler® Direct Kit loci and alleles

Locus Alleles included in AmpF(STR® Yfiler® Dye DNA Control
designation Allelic Ladder label 007
DYS456 13, 14, 15, 16, 17, 18 6-FAM™ 15
DYS389 | 10, 11, 12, 13, 14, 15 13
DYS390 18, 19, 20, 21, 22, 23, 24, 25, 26, 27 24
DYS389 Il 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34 29
DYS458 14,15, 16, 17, 18, 19, 20 vIc® 17
DYS19 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 15
DYS385 a/b 7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 11,14

21, 22, 23, 24, 25
DYS393 8,9, 10, 11,12, 13, 14, 15, 16 NED™ 13
DYS391 7,8,9,10, 11,12, 13 1"
DYS439 8, 9,10, 11,12, 13, 14, 15 12
DYS635 20, 21, 22, 23, 24, 25, 26 24
DYS392 7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18 13
Y GATA H4 8,9 10, 11,12, 13 PET® 13
DYS437 13, 14, 15, 16, 17 15
DYS438 8,9,10,11,12, 13 12
DYS448 17,18, 19, 20, 21, 22, 23, 24 19

Note: Additional virtual bins have been added to the Yfiler® allelic ladder bin set to
increase the number of peaks that can be assigned an allele label. Refer to Chapter 4,
“Analyze Data” on page 29 for additional information.

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide
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Product overview

Allelic ladder Figure 1 shows the allelic ladder for the Yfiler® Direct Kit. See “Allelic ladder
profile requirements” on page 23 for information on genotyping accuracy.

Figure 1 GeneMapper® /D-X Software plot of the AmpF(STR® Yfiler® Allelic Ladder
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Product overview

DNA Control 007 Figure 2 shows amplification of DNA Control 007 using the Yfiler® Direct Kit.
profile

Figure 2 DNA Control 007 (4 ng) amplified with the Yfiler® Direct Kit and analyzed on the Applied Biosystems® 3130x!
Genetic Analyzer
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Workflow

Chapter 1 Overview
Workflow
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Instrument and software overview

Instrument and software overview

Data Collection and

GeneMapper® ID
or ID-X Software

Instrument and
software
compatibility

About
multicomponent
analysis

How
multicomponent
analysis works

14

This section provides information about the Data Collection Software versions
required to run the Yfiler® Direct Kit on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Instrument Operating Data Collection Analysis Software
System Software
3500/3500xL e Windows® XP 3500 Series GeneMapper® /D-X Software
o Windows Data Collection | v1.2 or higher
Vista® Software v1.0
3130/3130x(* Windows® XP 3.0 » GeneMapper® ID
- Software v3.2.1
3100/3100-Avant | Windows® NT 1.1 (3100) and
10 [3100—Avant] ° GeneMapper® ID-X
Windows® 2000 20 Software v1.0.1 or higher

T Validation studies were conducted using these configurations.

Life Technologies fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent dye
colors into distinct spectral components. The four dyes used in the Yfiler® Direct Kit to
label samples are 6-FAM™, VIC®, NED"™, and PET® dyes. The fifth dye, LIZ®dye, is
used to label the GeneScan™ 600 LIZ® Size Standard v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Life Technologies instruments, the
fluorescence signals are separated by diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM ™ dye emits at the shortest wavelength and it is
displayed as blue, followed by the VIC® dye (green), NED" dye (yellow), PET® dye
(red), and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide
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Instrument and software overview

Figure 3 Emission spectra of the five dyes used in the Yfiler® Direct Kit
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Materials and equipment

Materials and equipment

Kit contents and
storage

The Yfiler® Direct Kit (Cat. no. 4477555) contains materials sufficient to perform
250 amplifications at 25 pL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component Description 250X Volume Storage
AmpFlSTR® Yfiler® Contains enzyme, salts, dNTPs, carrier 2 tubes, 1.25mL | -15°C to -25°C on receipt,
Direct Master Mix protein, and 0.04% sodium azide. 2°C to 8°C after initial use
AmpF(STR® Yiiler® Contains forward and reverse primers to 2 tubes, 0.55 mL

Direct Primer Set

amplify human male DNA target.

AmpF(STR® Yfiler®
Allelic Ladder

Contains amplified alleles. 1 tube, 50.0 uL

See Table 1 on page 10 for a list of alleles
included in the allelic ladder.

AmpF(STR® DNA
Control 007

Contains 2 ng/pL human male DNA in 1 tube, 50.0 yL
0.05% sodium azide and buffer.

See Table 1 on page 10 for profile.

AmpF(STR® PCR
Enhancer

Contains proprietary biochemical reagents. | 2 tubes, 1.44 mL

t+ The AmpF(STR® DNA Control 007 is included at a concentration appropriate to its intended use as an amplification control [i.e., to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR® DNA Control 007 is not designed
to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of the AmpF(STR®

DNA Control 007.

Standards for
samples

16

For the Yfiler® Direct Kit, the panel of standards needed for PCR amplification, PCR
product sizing, and genotyping are:

* AmpF/STR® Control DNA 007 — A positive control for evaluating the efficiency
of the amplification step and STR genotyping using the AmpF(STR® Yfiler®
Allelic Ladder.

* GeneScan'" 500 LIZ® Size Standard or GeneScan"" 600 LIZ® Size Standard
v2.0 — Used for obtaining sizing results. These standards, which have been
evaluated as internal size standards, yield precise sizing results for Yfiler® Direct
Kit PCR products. Order the GeneScan™ 500 LIZ® Size Standard
(Cat. no. 4322682) or the GeneScan" 600 LIZ® Size Standard v2.0
(Cat. no. 4408399) separately.

* AmpF/STR® Yfiler® Allelic Ladder — Allelic ladder developed by Life
Technologies for accurate characterization of the alleles amplified by the Yfiler®
Direct Kit. The AmpF(STR® Yfiler® Allelic Ladder contains most of the alleles
reported for the 17 loci. Refer to Table 1 on page 10 for a list of the alleles included
in the AmpF(STR® Yfiler® Allelic Ladder.

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide
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B Optimize PCR cyclenumber. ........ ... .. i i 17
B Preparethereactions .......... ... ... . 18
B PerformPCR ... . 21

Optimize PCR cycle number

Before using the Yfiler® Direct Kit for the first time, perform a single initial sensitivity
experiment to determine the appropriate cycle number to use during internal
validation studies and operational use of the Yfiler® Direct Kit. This experiment
accounts for instrument-to-instrument and sample-to-sample variations. If you are
processing multiple sample type and substrate combinations (for example, buccal
samples on treated paper and blood samples on untreated paper), perform separate
sensitivity experiments for each sample type and substrate to be used for testing.

The Yfiler® Direct Kit is optimized to amplify unpurified:

* Single-source blood samples on treated paper or untreated paper substrates

* Buccal samples on treated or untreated paper substrates
When amplifying single-source, unpurified samples using the Yfiler® Direct Kit, you
should expect to see greater variation in peak height from sample to sample than is

expected with purified samples. Careful optimization of the cycle number will help to
minimize the impact of this variation.

Select samples and 1. Select 26 of each sample and substrate type. Ensure the selected samples represent
prepare plates a “typical” range of samples analyzed in your laboratory.

IMPORTANT! The number of samples recommended for this study has been
chosen to allow you to complete electrophoresis using a single 96-well plate, thus
minimizing the impact of run-to-run variation on the results.

2. Prepare the samples and the reactions as described in the protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of three
replicate plates.

3. Create three identical PCR plates.

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide 17



2 Perform PCR
Prepare the reactions

Determine
optimum
conditions

S

Amplify each plate using a different cycle number to determine the optimum
conditions for use in your laboratory. Suggested cycle numbers for different
sample type and substrate combinations are listed below:

Substrate
Sample type
Treated paper Untreated paper
Blood 25, 26, 27 cycles 25, 26, 27 cycles
Buccal 26, 27, 28 cycles 26, 27, 28 cycles

Note: To minimize the effect of instrument-to-instrument variation, use the same
thermal cycler to amplify all three plates. To maximize result quality, prepare and
amplify Plate 1 then repeat for Plates 2 and 3. Do not prepare all three plates
simultaneously.

. Run the PCR products on the appropriate CE platform using the recommended

protocol; see Chapter 3, “Perform Electrophoresis” on page 23.

Based on the results of the sensitivity study, select the appropriate PCR cycle
number for future experiments.

Our studies indicate the optimum PCR cycle number should generate profiles with the
following heterozygote peak heights, with no instances of allelic dropout and minimal
occurrence of off-scale allele peaks.

Instrument Heterozygous peak height
31xx 1500-3000 RFU
3500 Series 3000-6,000 RFU

Prepare the reactions

Sample prep
guidelines

18

¢ Do not add water to the wells on the reaction plate before adding the punches. If

your laboratory is experiencing static issues with the paper discs, you may
prepare and dispense the 25 uL reaction mix into the wells of the reaction plate
before adding the punches.

For samples collected using the Bode Buccal DNA Collector'”, add 2 uL of Prep-
n-Go'" buffer (Cat. no. 4467079) to the sample and negative control wells in a 96-
well plate. Do not add Prep-n-Go'" Bulffer to the positive control wells.

Make the punch as close as possible to the center of the sample to ensure
optimum peak intensity. If you are using a Bode Buccal DNA Collector™", make
the punch as close as possible to the tip of the DNA collector to ensure optimum
peak intensity. Increasing the size of the punch may cause inhibition during PCR
amplification.

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide



Chapter 2 Perform PCR
Prepare the reactions

¢ For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card,
hold the barrel of the Harris Micro-Punch (do not touch the plunger), gently press
and twist 1/4-turn, then eject the punch into the appropriate well on the reaction
plate.

e For automated punching: Please refer to the User Guide of your automated or
semi-automated disc punch instrument for proper guidance.

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide 19
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Prepare the reactions

Prepare the
reactions

20

1.

Add samples to the reaction plate:

Add the following to wells of a MicroAmp®

Wellls) Optical 96-Well Reaction Plate

Negative control 1.2 mm blank disc

Test samples 1.2 mm sample disc

Positive control e For 25 and 26 3 pL of Control DNA 007
IMPORTANT! Do not add a cycles

blank disc to the positive e For 27 cycles 2 pL of Control DNA 007

control well.

Note: The volumes of positive control are suggested amounts and may be adjusted if
peak heights are too high or too low for your optimized cycle number.

Calculate the volume of each component needed to prepare the reactions, using
the table below.

Reaction component Volume per reaction
Master Mix 10.0 pL
Primer Set 3.5 L
PCR Enhancer 11.5 pL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! This kit has been optimized for a 25-uL PCR reaction volume to
overcome the PCR inhibition expected when amplifying unpurified samples.
Using a lower PCR reaction volume may reduce the ability of the kit chemistry to
generate full STR profiles.

Prepare reagents. Thaw the Master Mix, Primer Set, and PCR Enhancer, then
vortex for 3 seconds. Centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the reaction mix for 3 seconds, then centrifuge briefly.

Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate.

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide
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Perform PCR

7. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a
MicroAmp® compression pad (Cat. no. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti® Thermal Cycler does not require
a compression pad.

8. Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

Perform PCR

1. Program the thermal cycling conditions.

IMPORTANT! When using the GeneAmp® PCR System 9700 or the Veriti®
Thermal Cycler, select 9600 emulation mode.

Initial incubation Denature Anneal Extend Final hold
step
HOLD CYCLE (25-28) HOLD
95°C 94°C 58°C 61°C 4°C
1 min 11 sec 1 min 15 sec 2 min 30 sec oo

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Cat. no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
<2 weeks 2 to 8°C
>2 weeks -15t0-25°C

IMPORTANT! Store the amplified products so that they are protected from light.
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B Section 3.1 3100/3100-Avant and 3130/3130x] instruments . . ................ 24
Set up the 3100/3100-Avant or 3130/3130xl instrument for electrophoresis . ... 24
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x1
Instrument . ... 25

B Section 3.2 3500/3500xL Series Instruments. .. .........vuiirinninenn.n.. 27
Set up the 3500/3500xL instrument for electrophoresis ..................... 27
Prepare samples for electrophoresis on the 3500/3500xL instrument. ......... 27

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of allelic . _OnG:' Number of samples per
Instrument injection .
ladders to run equals allelic ladder(s)

3100-Avant or 3130 | 1 per 4 injections 4 samples 15 samples + 1 allelic ladder

3100 or 3130x( 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 injections 1 sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Set up the 3100/3100-Avant or 3130/3130x! instrument for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant or 3130/3130x! instrument for

electrophoresis

Reagents and parts

Electrophoresis
software setup and

“Ordering Information” on page 79 lists the required materials not supplied with the
Yfiler® Direct Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

the documents listed in the table.

The following table lists Data Collection Software and the run modules that can be
used to analyze Yfiler® Direct Kit PCR products. For details on the procedures, refer to

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3.0 Windows® ¢ HIDFragmentAnalysis36_POP4_1 | Applied Biosystems 3130/3130xl
Biosystems® XP Injection conditions: Genetic Analyzers Using Data
3130/3130x(* 3130 = 3 kV/5 sec Collection Software v3.0, Protocols for
Processing AmpF(STR® PCR
~ 3130x( = 3 kV/10 sec Amplification Kit PCR Products User
¢ Dye Set G5 Bulletin (Pub.no. 4363787)
3100 2.0 Windows® e HIDFragmentAnalysis36_POP4_1  3100/3100-Avant Genetic Analyzers
2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
Protocols for Processing AmpF(STR®
e Dye Set G5 e )
PCR Amplification Kit PCR Products
User Bulletin (Pub. no. 4350218}
1.1 Windows® e GeneScan3évb_DyeSetG5Module 3100/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpFISTR®
R . PCR Amplification Kit PCR Products
G5600v2.0Analysis.gsp User Bulletin (Pub. no. 4332345)
3100-Avant 1.0 Windows® e GeneScan36Avb_DyeSetG5Module = 3700/3100-Avant Genetic Analyzers
NT Protocols for Processing AmpFSTR®

Injection condition: 3 kV/5sec
GS600v2.0Analysis.gsp

PCR Amplification Kit PCR Products
User Bulletin (Pub. no. 4332345)

T We conducted validation studies using these configurations.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments 3
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instrument

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di'"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.5 L
Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.
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2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Add into each well of a MicroAmp® Optical 96-Well Reaction Plate:

* 9 uL of the formamide:size standard mixture
¢ 1 pL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di™ Formamide.

5. Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.
Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

e © ®©® =2 o

Start the electrophoresis run.
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Section 3.2 3500/3500xL Series instruments 3
Set up the 3500/3500xL instrument for electrophoresis

Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 79 lists the required materials not supplied with the
Yfiler® Direct Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

w
a
o
o
w
[$)]
o
o
x
=
>
(2]}
=
=
=
3
@
=)
=
(2}

Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Yfiler® Direct Kit PCR products. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3500 Data | Windows® e HID36_POP4 Applied Biosystems® 3500/3500xL
Biosystems® | Collection | XP Injection conditions: 1.2kV/15 sec ~ Genetic Analyzer User Guide
3500 Software (Pub. no. 4401661)
1.0 or ¢ Dye Set G5
. ; ; ®
Applied Windows e HID36_POP4 Applied Biosystems™ 3500 and
Biosystems® Vista® Injection conditions: 1.2kV/24 sec 3500 Genetic Analyzers Quick
3500xL. ) o Reference Card (Pub. no. 4401662)
e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.5 L
Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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e © ®©® =2 o

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Add into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® ID Software

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in an .fsa file. Using GeneMapper® ID Software v3.2.1, you can then analyze and
interpret the data from the .fsa files.

Instruments Refer to “Instrument and software overview” on page 14 for a list of compatible
instruments.
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Set up GeneMapper® ID Software for data analysis

Before you start

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with AmpF(STR® kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the + 0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

Before using the
software for the
first time

30

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID Software.

Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for
the first time, you need to:

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 31.

Create an analysis method, as explained in, “Create an analysis method” on page
34.

Create a size standard, as explained in “Designate size standard” on page 40.

Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.

Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.
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Set up GeneMapper® ID Software for data analysis

Impo rt panels and To download the most recent versions of the Yfiler® panel and bin set go to
bins www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID Software:
1. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need login instructions, refer to pages 2-7 of the GeneMapper®
ID Software Version 3.1 Human ldentification Analysis User Guide (Pub. no. 4338775).

2. Select Tools » Panel Manager.

3. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

(#) Panel Manager
File Edit Bins View

=) NN .I.I.IlE:ins.at:

B Panel Manager |

Highlight this.
|

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder, where x is the drive on which the GeneMapper® ID Software is

installed.
4. Select AmpFLSTR_Yfiler_Panels_v3.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, Yfiler_Panels_v3. This folder contains the panels and associated

markers.

7 import Panels

Loskin |0 Panets v 2 EE

[F] AnpFLSTR_Bins w1
ab =] AmpFLETR_Bins vz

AnpFLETR_Paneis_vl
=| AMpFLSTR_Panels_v2

! ] AmpFISTR_Ytiler_Bin_v2
Q El ARpFLSTR vfier_Bins_v3

E) AmpFISTR viiler_Panel_v2

fwl
i
i
&
{ N I

Deskop
AmpFLSTR_ Y¥iiles Panels v
Tty Docurnent s
Iy Compuber
i File reme: AmpFLETR_Yfler_Panels_v3ixd
Wy Metarork ==
Places Files oftype: |4 Files b
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4 Analyze Data
Set up GeneMapper® ID Software for data analysis

5. Import AmpFLSTR_Yfiler Bins_v3:

a. Select the Yfiler_Panels_v3 folder in the navigation pane.

Fle Edit Bns ‘ew

X W W N H M o || I M ]
Bl EPanel Manager | Pl Hame [
] AmpFLSTR *iler_Panelv2 1 |\_r’1ilerfanels_v3 ||

W iler Paneis w3

= T

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder.

d. Select AmpFLSTR_Yfiler_Bins_v3, then click Import.

Note: Importing this file associates the bin set with the panels in the
Yfiler Panels_v3 folder.

#1im port Bin Sat

k Loak it |ijnn9Is "l I ,P||E

; % [] AmprLSTR_Bins_v1
; (5] ivrpFLETR_Bing_v2

Wty ecert [Z] merprLSTR_Panets_v
DOCUMENS | | (] syyoFl STR_Pancls_v2

() mrpRISTR_veler_Bin_v2
B arpFLSTR vl Bins v
Destiop [F] MerpPISTR_Vlar_Panel_v2
[F] merpFL STR_vfiler_Pareis_w3

My DocLiments
Wy Cotmptze
2 e
by Metweark
Places Filez of type: | oy Fliez bt cancel

6. View the imported panels in the navigation pane:

a. Double-click the Yfiler_Panels_v3 folder.
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b. Double-click the Yfiler_v3 folder to display the panel information in the
right pane and the markers below it.

Panel Manager
File Edit Bins Yiew
B KW m W M| e v HEE=n (unnnnn
= = Parel Maracer | |Momverlmw  |Dye Color | BIm sim |Maw Slm | Cirorol Aleles ke | M ¢ Copusens Ledtir Alkles
# ] AmEFLSTR Y fier_Panel_v2 i _Cv=456 e 100.0 1270 15 4 013 none 1314151617.18 ®
B T Ne Fanss v3 2 |BOVE38d ks 1340 1780 13 4 042 rnone 1041,121314,15 g
- ST 3 |BDYS380  |ous 1650|2450 |24 + 01 none 18,18,20,21 22,23,24,25 26, %
E_pvesn 4 |BOvs3dl  |oe |60 |30z0 |23 + (018 none 24.15.25.27 26.28.30.3 32, )
E_nvsman 5 |B_0wsasE  |geen (1230 [R50 |17 f 012 rone 14151617 18,18,10 =z
B D334l B |G 0vES green (1670 (280 |15 n 011 rane 10,11,1213,0 4,1 5,067 18, Q@
gf):::ﬁ 7 |covsaes  |geen |20 [mzan [ 4 014 rone FEIN011,12,13,18,15,16; —
G_pYsans G |7 OvE3aE  |yelow (1040 1440 |13 f 013 rone 8a10,11,121314,15,16 8
_[¢5393 9 [v_ovsam |yelow 1480 w0 |11 n 012 rone 73210111213 o
S,
= ao|r_Dvsazs fveiow [1920  [2380 |12 + 011 rone 53,10,11,121314,15 =4
_[i¢sasn
‘(])YSSSS 11 |Y_OWSEES yelomy (2470 2T4n 24 4 011 nane 20,1 ,2223,24 25,06 9)‘
v_prsagz 12 [v_owsaaz  |yelow |2860  |33E0 |13 3 016 rone 7E3A1011,12131415 167 Y
R_r_GATA_H4 13 |R_Y_BaTA_H [red 140 1500 (13 + a1 none 53,10,11,1213
el 14 [R_OVSET  redt 1740 [2100 |15 4 00a  pane 1314151817
R_Dv5438
i 15 |R_DVE43E  |red 215E 465 |12 5 004 rone 830,112,132
15 |R_DYS448  [red 2130 |aazn |19 6 005 rone 17,16,19,20,21,22,23,24
=lReference Samples |
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7. View the markers and display the Bin view in the navigation pane:
a. Select the Yfiler_Panels_v3 folder to display its list of kits in the right pane.
b. Double-click the Yfiler_v3 folder to display its list of markers below it.
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c. Select DYS389II to display the Bin view for the marker in the right pane.
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Note: Two additional virtual bins, 23 and 35, have now been added. In total,
53 additional virtual bins were added to Yfiler_Bins_v3.txt.

8. Click Apply, then OK to add the AmpF(STR® panel and bin set to the

GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and

bins are not imported into the GeneMapper® ID Software database.

Create an analysis The HID Advanced analysis method for the Yfiler® Direct Kit uses the Yfiler Bins_v3

method file described in step 5 on page 32.

Use the following procedure to create a HID analysis method for the Yfiler® Direct

Kit.
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1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

(@] GeneMapper Manager

| Tale Settirgs | Piot Settings || Matrices | Size Standards
Iarre Laszt Saved Orvrier Instrurment Analysis Type Dezcription
IdertifilerDirect_HID_1 2010-02-05 10:24:1 | genicd HIC Default Identifier O _|
Identifiler_Plus_Analysishlet (2011-05-19 14:41:1 |gmid HID Default analysis
Wicrosatellte Default 2010-01-27 14:55:0 | grnid Wicrosatelite Factary Provided 3
< I

ey Open... Save Az, Expoart... Delete

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

)
()
>
()
=
[
O
O
g
<)
O
(9]
o
=
=
(V)
=
()

3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.
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General tab

. Analysis Method Editor - HID '
settings S X
| General | allete || Peak Detector | Peak Qualty | cusity Flags |
~&nalysis Method Description
Hame: | ‘iler_srialysishethac_2] |
Description: ~
W
Instrument:
Analysis Type: HID
[ Ok ] [ Cancel ]

In the Name field, either type the name as shown, or enter a name of your choosing.
The Description and Instrument fields are optional.
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Allele tab settings

Analysis Method Editor

| General | Allele | peak Detector | Peak Quality | 5Q & GQ Settings |
Bin Set: | Yfiler_Bins_v3 w |
®
Lise marker-spedfic stutter ratio and distance if available %
QO
Marker Repeat Type: Tri Tetra Penta Hexa §
Global Cut-off Value 0.1 0.1 0.1 0.1 é@
MinusA Ratio 0.0 0.0 0.0 0.0 g’
MinusA Distance From 0.0 0.0 0.0 0.0 g
To 0.0 0.0 0.0 0.0 ®
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From 0.0 3.25 0.0 0.0
Toe |0.0 4,75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From |0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Amelogenin Cutoff 0.0
Range Filter... Factory Defaults
[ Save ] [ Cancel ] [ Help ]

* In the Bin Set field, select the Yfiler_Bins_v3 bin set imported previously and
configure the stutter distance parameters as shown.

* GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Yfiler_Panels_v3.txt
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file, select the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Peak Detector tab 3
. Analysis Method Editor - HID
settings e =)
General | Allele | Peak Detector | Peak Quality | Quslty Flags
Peak Detection Algarithm: |&Advanced hd
Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds: E?g_?];T
Full Range  + All Sizes hd . . N .
B: |50 R |50 validation
G: |50 0: | 50 || studiesto
determine
v |50 settings
—Stmacthing and Baselining '
Mir. Peak Half Wicth: 2 pts
Smoathing ) None ) 5
@ Light Palynamial Degree:
() Hearwy Peak Wyindow Size: 15 pts
Baszeline Windawy: | 51 pt= Slope Threshold
Peak Start: 0o
—=ize Calling Method Pesk End: oo

() 2nd Order Least Sguares
(:) 3rd Order Least Sguares
() Cubic Spline Interpolation
(%) Local Southern Method
() Global Southern Method

[ Factory Defaults ]

ok | [ comeet |

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of Yfiler® Direct Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

* Size calling method - The Yfiler® Direct Kit has been validated using the Local
Southern sizing method. Before using other sizing methods, perform internal
validation studies.

38 AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide



Section 4.1 GeneMapper® ID Software 4
Set up GeneMapper® ID Software for data analysis

Peak Quality tab

settlngs Analysis Method Editor - HID
| General | alete | Peak Detector | Peak Quality | qualty Flags Perform
|—Siclnal vl internal
validation
Homozygous min peak height I:I\ studies to
Heterozygous min peak height I:I determine
settings
’-Heternzygclte halance g)
’ . . >
Min peak height ratio o)
S <
~Peak motphology %
°
Max peak width (hasepairs) 2@
Pull-up peak O
n
Pull-ug ratio 0.0s S
=
£
o
=
(0]

~Allele number

I

Max expected aleles

’ Factory Defaults ]

(o | [ coment |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold for interpretation of Yfiler® Direct Kit data.

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide 39



4 Analyze Data
Set up GeneMapper® ID Software for data analysis

Quality Flags tab

settings Analysis Method Editor - HID %]
General | Alele | Peak Detector | Peak Quality | Qualty Flags
Quality weights are betvween 0 and 1 .
—Gwalty Flag Settings
Spectral Pull-up 0s Control Concordance 1.0
Broad Peak 0a Loy Peak Height 03
Qut of Bin Allele 0a Off-scale 08
Evizileg o0& Peak Height Ratio 0.3
PO Thresholds
Pass Range: Lowy Guality Range:
Sizing Guslity: From | 073 to1.0 From0.0to | 025
Genotype Quality: From | 0.75 to1.0 From O0to | 025
’ Ok I ’ Cancel I
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values for interpretation of Yfiler® Direct Kit data.
Designate size For the Yfiler® Direct Kit , use the following size standard peaks:
standard
GeneScan™ 500 LIZ® Size Standard peak = GeneScan™ 600 LIZ® Size Standard v2.0
sizes peak sizes
75, 100, 139, 150, 160, 200, 300, 340, 350, 400, | 80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
and 450 240, 250, 260, 280, 300, 314, 320, 340, 360,

380, 400, 414, 420, 440 and 460

Note: The 250-nt peak in the GeneScan™" 500 LIZ® Size Standard is not included in the
size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

40 AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide



Section 4.1 GeneMapper® ID Software 4
Analyze and edit sample files with GeneMapper® ID Software

2. Select the Size Standards tab, click Open, select the CE_G5_HID_GS500 size
standard, then click Done.

() GeneMapper Manager

| Projects || &nalysis Methods || Table Settings | Plot Settings | Matrices | Size Standards
Mame Last Saved Cravner Type Dezcription
| CE_G5_HID_G:S500 2010-09-08 15:04:% | gict Basic/Advanced |_:J

Meswy . Open Save As Expaort.. Delete

Analyze and edit sample files with GeneMapper® ID Software

)
®
>
o
=
Q
e}
O
@
<)
O
(9]
[©]
=
=
Q
=
(0]

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method YfilerDirect_AnalysisMethod_v1 (or the name of the analysis
method you created)
Panel Yfiler_v3
Size Standard CE_G5_HID_GS500% (or the name of the size standard you
selected)

t The Yfiler® Direct Kit was originally validated using the GeneScan™ 600 LIZ® Size Standard v2.0. If you
use the GeneScan™ 500 LIZ® Size Standard as an alternative, perform the appropriate internal validation
studies to support the use of this size standard with the Yfiler® Direct Kit.

Note: For more information about how the Size Caller works, refer to the
GeneScan® Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).

3. Click B (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.
e The status bar displays the progress of analysis:
— As a completion bar extending to the right with the percentage
indicated

— With text messages on the left
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Examine and edit a project

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Genotypes tab becomes available after analysis (see the figure on the
next page).
Project window after analysis

F ! GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit Analysis View Tools Help

i B N £l B &  TebleSeting  |AmpFLSTR Table v | H s =
= EProject Samples |
|ijiIer Example Status | Sample File Sample Type | Analysis Method Panel Size Standard Rur Marne
1 !,,q Allelic Ladder fza | Allelic Ladder | filer _Analysishethod_w2 DS33 CE_F_HID_GS500 (75-450) “iler Example
2 !,,q Sample 1 .fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
3 !,,q Sample 10.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
4 !,,q Sample 11 fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
5 !,,q Sample 12.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
B !,,q Sample 13.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
7 !,,q Sample 14 fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
g !,,q Sample 15.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
9 !,,q Sample 16.fsa Posttive Control | Y filer_AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
10 !,,q Sample 17 fsa of v filer _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
ih! !,,q Sample 15.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
12 !,,q Sample 19.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
13 !,,q Sample 2.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
14 !,,q Sample 3.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
15 !,,q Sample 4. fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
16 !,,q Sample 5.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
17 !,,q Sample 6.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
18 !,,q Sample 7 .fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
19 !,,q Sample 5.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
20 !,,q Sample 9.fsa Sample iler _AnalysisMethod_v2 DS33 CE_F_HID_GS500 (75-450) Yfiler Example
< ' 2|
IProgress Statuz ... | 0%

For more information about any of these tasks, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (Pub. no. 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).
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For more information

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:
*  GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub. no. 4335523)
*  GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide
(Pub. no. 4338775)

e Installation Procedures and New Features for GeneMapper® ID Software Software
Version v3.2 User Bulletin (Pub. no. 4352543)
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Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file or a .hid file. Using GeneMapper® ID-X Software, you can then analyze
and interpret the data from .fsa files (GeneMapper® ID-X Software v1.0.1 or higher) or
hid files (GeneMapper® ID-X Software v1.2 or higher).

Instruments Refer to “Instrument and software overview” on page 14 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR® kits, be aware that:

44

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you

stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
software for the higher for .hid files) to analyze data for the first time, you must do the following:

first time 1. Check the version of panel, bin, and stutter files installed with the GeneMapper®
ID-X Software as explained in “Check panel, bin, and stutter file version” below.
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2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software to determine if newer files are available.

3. If updated files are available, download and import the files into the
GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 46.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on
page 50.

5. Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

6. Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

For more For quick set up instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting
information Started Guide (Pub. no. 4375574).

For details about GeneMapper® ID-X Software features, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)
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Check panel, bin, 1. Start the GeneMapper® ID-X Software, then log in with the appropriate user
and stutter file name and password.
version

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

2. Select Tools » Panel Manager.

3. Check the version of files imported into the Panel Manager:

) . ) »* Panel Manager
a. Select Panel Manager in the navigation pane. Rl Edt Bins View Help
O = i@

E28 .=, Panel Manager

b. Expand the Panel Manager folder and any sub-
folders to identify the analysis file version already
installed for your kit choice.

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described

below.
Import panels, To import the latest version of the Yfiler® panel, bin set, and marker stutter from our
bins, and marker web site into the GeneMapper® ID-X Software database:
stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file Yfiler v1.3X PBS.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

b. Select File » Import Panels to open the Import . Panel Manager

Panels dialog box.

c. Navigate to, then open the Yfiler v1.3X PBS folder
that you unzipped in step 1 on page 46.

File Edit Bins Wiew Help
O = T

E2R .-, Panel Manager
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5. Select Yfiler_Panels_v1.3X (or the version you installed), then click Import.

Note: This folder contains the panel and associated markers.

6. Import Yfiler Bins_v1.3X.txt:

a. Select the Yfiler_Panels_v1.3X folder in the navigation pane.

#* Panel Manager
File Edit Bins Wew Help

di' X |ﬁ’ i # B ™ BinSet: |Yfiler_Bins_v1.3X 2
B---d_%ﬁPaneI Manager Parwel Hame [ ormrment
i IC2) AmpFLSTR_Panels_w3X 1 [rriler _Panels_v1.3% ndll

E=8 i Yfiler_Panels_v1.3X

o
(0]
2
(0]
<
QO
©
e}
@
(©)
S
<
w
o
=3
=
3
(0]

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the Yfiler v1.3X PBS folder.
d. Select Yfiler_Bins_v1.3X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
Yfiler Panels_v1.3X folder.

#* Import Bin Set

Lookin: | () Yfier v1.3X PBS v @ @EE
Ty "|";°"j Yfiler_Bins_v 1. 3X.txt |
L&b [£] ¥iler_Panels_v1.3%.tet
My Recent [Z] viler _Stutter_v1.3X.txt
Documents
=
[
Desktop
s
My Documents
X El File name: | | l Impart ]
My Computer Files of type: |.|!\JI Files vl Cancel

7. View the imported panels in the navigation pane:
a. Double-click the Yfiler_Panels_v1.3X folder.
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b. Double-click the Yfiler_v1.3X folder to display the panel information in the
right pane.

#* Panel Manager

File Edit Bins View Help
-Gl o N N R BinSEt=|Yﬁ|Ef_BiﬂS_V1-3x "| WLEEE BDEEBEEEN
- o, Panel Manager | Biker Mg Drve Color |Min Sim | Max Size | Cortrol Allelss Mirker | Corrmerts ¥ Mrker | Ladder Alleles
- [C) AmpFLSTR Panels_v3X | [1 [F_DVo986 Blue (980  [123.0 |15 4 none @] 13,14,15,16,17,18
=00 Yfiler_Panels_v1.3X 2 |BDYS389l  |Blue 130 |178.0 |13 4 none 0O 10,11,12,13,14,15
S vfier_Pancis v 1. i Py B 185.0  |z44.0 |24 4 18,19,20,21,22,23,24,25,2
"B_DYS456 | ue : : none F ,19,20,21,22,23,24,23,
B DY53891 2 [BDVS38AIl |Blue  |246.0 3020 |29 4 none 0 24,25,26,27,28,29,30,31,3
-B_DYS390 5 |G_DYS458  |Greem |1z6.0  |170.0 |17 4 rone 0 14,15,16,17,18,19,20
BT 6 |G_D513 Green (1730 (2190 [15 4 |none 00 [101L1213,14,15,18,17,1
- G_DYS458
T 7 |G_DYS385  |Green  |235.0  |323.0  |11,14 4 none O 7,89,10,11,12,13,14,15, 1t
e 8 |v_DV5393 vellow  |100.0 |144.0 |13 4 rone 0 8,9,10,11,12,13,14,15, 16
-Y_DY5393 9 |v_DY5391 vellow (1460  [181.0 |11 4 none 0 7,8,9,10,11,12,13
-¥_DY5391 10 |¥_D¥5439 vellow [192.0  |z3aod |12 4 none O 5,9,10,11,12,13,14,15
-¥_DY5439
e 11 |¥_DV5635 vellow |232.0  |280.0 |24 4 rione 0 20,21,22,23,24,25,26
v OYs392 12 [¥_D¥5392 vellow  |Ze6.0  |335.0 |13 3 none 0 7,6,9,10,11,12,13,14,15, I¢
‘R_Y_GATA_H4 13 |R_V_GATA_H4 |Red 114.0 [160.0 |13 4 none 0O 8,9,10,11,12,13
‘R _DY5437 14 |R_DYS437 Red 174.0  |21000 |15 4 none O 13,14,15,16,17
‘R_DYS433
e 15 |R_DY3438  |Red zI55 2565 |12 5 none 0 8,9,10,11,12,13
16 |R_D¥5448  |Red 2840 3320 |19 & rone 0O 17,18,19,20,21,22,23,24

8. Select and expand Yfiler_v1.3X in the navigation pane, then select DYS389II to
display the Bin view for the marker in the right pane.

»* Panel Manager

File Edit Bins View Help
p g (@ W | Binset: i o m ~
BF 3 & B M | (8 W BinSet|Yfler_Bins_v1.3X vy MLESRE BEEEEEE ¢
B."&PEHEI e 23 24 25 26 27 28 29 a0 31 32 33 24 25
t D) AmpPFLSTR_Panels_v3xX 10
=129 Yfiler_Panels_w1.3X
=13 Yfiler_Panels_w1.3X
' 0.3
g
o7
0E
0.5
0.4
0.3
------ 55, Reference Samples
nz
01
0o
241 243 245 247 249 231 232 255 257 299 261 262 265 267 269 271 27E 275 277 IO 284 202 295 207 209 291 299 295 207 209 301 202 203 207
B_DYS2E011
£ &2
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9. Import AmpFLSTR_Stutter_v2X:
a. Select the Yfiler_Panels_v1.3X folder in the navigation panel.

#* Panel Manager
File Edit Bins Wiew Help

ait B & B ™ BinSet: |Yfiler_Bins_v1.3X 3
B---&Panel Manager Tarel Mg [ ——
E AmMpFLSTR._Panels_w3X 1 [rbiler_Panels_w1.3% rll

E=8 i Yfiler_Panels_v1.3X

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the Yfiler v1.3X PBS folder.
d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_v2X folder.

(@)
(0]
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(0]
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SE
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»* Import Bin Set El
Lookin: |[3) Yfiler v1.3X PBS v @S
Ty [Z] viler Bins_v1.3%.tet |
@ [Z] ¥iler_Panels_v1.3%.txt
My Recent [Z] viler _Stutter_v1.3%.txt
Documents
=
[
Desktop
My Documents
'__E! File name: | | [ Impart ]
My Computer Files of type: |Al| Files ~ | Cancel

10. View the imported marker stutters in the navigation pane:

a. Double-click the Yfiler_Panels_v1.3X folder to display its list of kits in the
right pane.

b. Double-click the Yfiler_v1.3X folder to display its list of markers below it.

11. Click Apply, then OK to add the Yfiler® panel, bin set, and marker stutter to the
GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis Use the following procedure to create an analysis method for the Yfiler® Direct Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

Projects | Analysis Methods | Table Settings | Plok Settings | Matrices | Size Standards | Report Settings

Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter settings in all tabs, click Save.
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General tab

settings Analysis Method Editor
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
—Analysis Method Description
Mame: |‘|"ﬁlerDirect Analysis Method |
8
Security Group: |Genel‘~"|apper ID-X Security Group w | %
35
)
Description: - Q@
E S
£ <
)
o)
=
s
Instrument: L
1)
Analysis Type: HID
[ Save H Cancel ” Help ]

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are

optional.
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Allele tab settings

52

Analysis Method Editor X
| General | Allele | peak Detector | Peak Quality | 5Q & GQ Settings |
Bin Set: |Yﬁ|er_Ein5_u1.3x w |
Use marker-spedfic stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.1 0.1 0.1 0.4
MinusA Ratio 0.0 0.0 0.0 0.0
MinusA Distance From |0.0 0.0 0.0 0.0
To |00 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To |00 4.75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From 0.0 0.0 0.0 0.0
To |00 0.0 0.0 0.0
Amelogenin Cutoff 0.0
Range Filter... Factory Defaults
[ Save ] [ Cancel ] [ Help ]

* In the Bin Set field, select the Yfiler_Bins_v1.3X bin set and configure the Global
cutoff value as shown. These settings were used during developmental validation
of the Yfiler® Direct Kit.

Note: Applying global stutter ratios may reduce the editing required for single-
source sample data. Perform internal validation studies to determine the
appropriate filter setting to use.

¢ To apply the stutter ratios contained in the Yfiler_Panel_v1.3X.txt file, select the
“Use marker-specific stutter ratio if available” check box (selected by default).
Perform internal validation studies to determine the appropriate filter setting to
use.
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Peak Detector tab : ; y
. Analysis Method Editor, &
settings

General | Allele | i| Peak Quality | 50 & G0 Settings

Peak Detection Algorithm: Advanced

Ranges Peak Detection
Al Sizi ) Perform
FnEI'I 5:'5 - | ;:I'IS';I - Peak. Amplitude Thresholds: internal
ull R.ange izes . .
9 B: | R | validation o
G | | 0 | | studies to o
) determine 2
¥ l—‘ settings [
~amoothing and Baselining ke
Min. Peak Half Width: 2 pts '8
Smoaothing ) Mone S
i : 3
) Light Polynomial Degree 5
() Heawy Peak Window Size: 15 pts \
Baseline Window: pts Slope Threshold g)
Peak Start: 0.0 g
r3ize Calling Method Peak End: o %

(") 2nd Order Least Squares
() 3rd Order Least Squares
(") Cubic Spline Interpalation
() Lacal Southern Methad
(") Global Southern Method

Factory Defadls

[ Save As ][ Save ][ Cancel ][ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of Yfiler® Direct Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

* Size calling method — The Yfiler® Direct Kit has been validated using the Local
Southern sizing method. Select alternative sizing methods only after you perform
the appropriate internal validation studies.

* Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems® 3500 Series Genetic Analyzers. Users of this version of
software should perform laboratory evaluations to determine whether to use the
Normalization feature for analysis of Yfiler® Direct Kit data.
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Set up GeneMapper® ID-X Software for data analysis

Peak Quality tab

) Analysis Methed Editor &
settings

mIMax Peak Height (LPH{MPH] \

Homozygous min peak. height I:I Perform

Heterozygous min peak height I:I internal

Max Peak Height (MPH) [ ] ;,ﬂ'giztsﬁg
determine
settings

Peak. Height Ratio (PHR)

@ peak height: ratio I:l /
Broad Peak (BDY

—
o

Max peak width (basepairs)

Allele Mumber (AR

I

Max expected alleles

Allelic Ladder Spike
Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

IMPORTANT! Perform internal validation studies to determine the minimum
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold and the minimum peak height ratio threshold for interpretation of
Yfiler® Direct Kit data.
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Section 4.2 GeneMapper® ID-X Software 4
Set up GeneMapper® ID-X Software for data analysis

SQ & 6Q tab _ _ _
settings Analysis Method Editor [x)

| General | Allele | Peak Detector || Peak Quality | 50) & G Settings |

Cuality weights are between 0 and 1,
rSample and Contral GO Weighting

Broad Peak (B 0.5 Allele Mumber (AR 1.0
Cuk of Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Cwerlap (OYL) 0.8 Max Peak Height: (MPH) 0.3
Marker Spike: (SPK) 0.3 Off-scale (05) 0.8

Peak. Height Ratio (PHR) 0.3

Control Concordance (CC) Weight = 1.0 (Only applicable to contrals)

30 weighting
Eroad Peak (ED)

rallelic Ladder G0 weighting
Spike [S5PKSPK) Off-scale (03)

~S0 & GO Ranges

(@)
(0]
=}
(0]
<
QO
©°
e}
SE
)]
S
<
wn
o
=3
=
D
(0]

Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025

Genobype Guality:  From | 0.73 to 1.0 FromO.0ko | 025

Reset Defaulks

I
i
h=]

[ Save As ][ Save ][ Cancel ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.
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Analyze and edit sample files with GeneMapper® ID-X Software

Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings

Sample Type Select the sample type.

Analysis Method | YfilerDirect_AnalysisMethod_v2X (or the name of the analysis
method you created)

Panel Yfiler_v1.3X
Size Standard GS600_LIZ_(80-400)

For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper® ID-X Software v1.2 Reference Guide (Pub. no. 4426481A).
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Section 4.2 GeneMapper® ID-X Software

Examine and edit a project

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

#* GeneMapper® ID-X - Yfiler Example - gmidx Is Logged In Database GBOLDROYNJOSE

(@)
(0]
=}
(0]
<
Q
©°
e}
SE
)]
S
<
wn
o
=3
=
D
(0]

File Edit Analysis Wiew Tools Admin  Help
o ﬁ % g E| Ul Eﬁ [ 3 @ Table Setting:  |31%¥ Data Analysis W | ,O =K B a
B---&bproject : Samples| Analysis Summary | Genotypes
-1y ¥filer Example =
Analysis Summary =
Select run Folder to display:
( Sarmple Status [ Total # of Samples |
[ﬁ Unanalyzed 0
Analyzed 14
[ analysis Setting Changed 0
Click a link below to display a filtered Samples Tahle containing only the samples selected.
Allelic Ladder Quality per run folder {based on SQ and CGQ only)
Run Folder [ Total # of Analyzed Ladders ] [ & [ r]
‘iler Example 3 | 3 0 1] |
Control Quality per project (based on sample POVs: S80S, SSPK, MIX, OMR, 5Q, CGQ)
Control Type Total # of Samples ] All thresholds met [ O One of more thresholds not o
Positive Contral i} a a
Custom Control ] 0 0
Megative Control i} i} i}
Takal a a a
Sample Quality per project {based on sample POVs: S0S, S5PK, MIX, OMR, SQ, CGQ)
[ ][ Total # of Samples ] Al thresholds met ][ 0 One or more thresholds not i
Samples | 11 | 0 | 11 v
< | ¥
Analysis Completed, | Stop

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information

For more information, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)

o GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub. no. 4426482)

»  GeneScan® Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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This chapter provides results of the developmental validation experiments we
performed using the Yfiler® Direct Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

We performed experiments to evaluate the performance of the Yfiler® Direct Kit
according to the DNA Advisory Board (DAB) Quality Assurance Standards, effective
October 1, 1998 (DNA Advisory Board, 1998). The DAB standards describe the quality
assurance requirements that a laboratory should follow to ensure the quality and
integrity of the data and competency of the laboratory.

We performed additional studies according to the revised guidelines from the
Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). This
DNA methodology is not novel (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2001).

Based on these standards, we conducted experiments which comply with Standards
1.0 and 2.0 and its associated subsections. Whereas this DNA methodology is not
novel, Standard 8.1.2 and its related subsections have been addressed (Holt et al., 2001
and Wallin et al., 2001). This chapter will discuss many of the experiments we
performed and examples of the results we obtained. We used conditions that produced

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide 59



5 Experiments and Results
Developmental validation

maximum PCR product yield and a window in which reproducible performance
characteristics were met. These experiments, while not exhaustive, are appropriate for
a manufacturer, in our opinion. Each laboratory using the Yfiler® Direct Kit should
perform appropriate validation studies.

Note: The Yfiler® Direct Kit is intended for use on unpurified, single source blood
samples on FTA® treated or untreated paper, or buccal samples on FTA® treated paper
only. We did not perform mixture or inhibition studies during the developmental
validation of the Yfiler® Direct Kit, as the results would bear no relevance to the
intended use of this chemistry.

Developmental validation

SWGDAM Guideline
1.2.1

SWGDAM Guideline
2.1.0.1

PCR components

Thermal cycler
parameters

60

“Developmental validation is the demonstration of the accuracy, precision, and reproducibility
of a procedure by the manufacturer, technical organization, academic institution, government
laboratory, or other party.” (SWGDAM, July 2003).

Critical reagent concentrations and reaction conditions (such as thermal cycling
parameters, AmpliTaq Gold® DNA polymerase activation, cycle number) to produce
reliable, locus-specific amplification and appropriate sensitivity have been
determined.

“The reaction conditions needed to provide the required degree of specificity and robustness
must be determined. These include thermocycling parameters, the concentration of primers,
magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, July 2003).

The concentration of theYfiler® Direct Primer Mix, Yfiler® Direct Master Mix and PCR
Enhancer were evaluated. The concentration for a particular component was
established to be in the window that meets the reproducible performance
characteristics of specificity and sensitivity.

Thermal cycling parameters were established for amplification of the Yfiler® Direct
Kit in the GeneAmp® PCR System 9700. Thermal cycling times and temperatures of
GeneAmp PCR systems were also verified on the Veriti® thermal cycler. Annealing
and denaturation temperature windows were tested around each stipend to verify that
a =1.0°C window produced a specific PCR product with the desired sensitivity of at
least 1 ng of AmpF(STR® Control DNA 007.

The effects of denaturation and annealing temperatures on the amplification of Yfiler®
Direct Kit loci were examined using AmpF(STR® Control DNA 007 and two DNA
samples.

Denaturation times of 10, 15, and 20 seconds were tested at a denaturing temperature
of 94°C on the GeneAmp® PCR System 9700. The annealing temperatures tested were
57,58, 59, and 61°C for 30-, 60-, 90-, 120-, and 180-second hold times in the GeneAmp®
PCR System 9700 with the silver 96-well block. The PCR products were analyzed using
the 3130x/ and 3500 Genetic Analyzers.

Based on multifactorial analysis, denaturation conditions of 11 seconds at 94°C and
annealing for 75 seconds at 58°C yielded the most robust profiles with regard to peak
height and intracolor balance.
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Chapter 5 Experiments and Results

Accuracy, precision, and reproducibility

PCR cycl_e number The Yfiler® Direct Kit reactions were amplified for 26 and 27 cycles on the GeneAmp®
PCR System 9700 using blood samples on FTA®, buccal samples on FTA®, and 007
male control DNA. As expected, PCR product increased with the number of cycles.

To determine the cycle number that gives optimal sensitivity, we recommend analysts
perform a sensitivity study amplifying their sample types for 25 to 27 cycles. Select the
cycle number that generates average peak heights of 1000 to 3000 RFU on a 3130/3130x!
platform with minimal off-scale peaks. See “Optimize PCR cycle number” on page 17.

Accuracy, precision, and reproducibility

SWGDAM Guideline “The extent to which a given set of measurements of the same sample agree with their mean and
2.9 the extent to which these measurements match the actual values being measured should be
determined.” (SWGDAM, July 2003).

Laser-induced fluorescence detection systems of length polymorphism at short
tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al., 2001).
However, accuracy and reproducibility of Yfiler® Direct Kit profiles have been
determined from various sample types.

Figure 4 illustrates the size differences that are typically observed between sample
alleles and allelic ladder alleles on the 3100 Genetic Analyzer with POP-4%® polymer.
The x-axis in Figure 4 represents the nominal base pair sizes for the AmpF(STR®
Yfiler® Allelic Ladder, and the dashed lines parallel to the x-axis represent the +0.5-bp
windows. The y-axis is the deviation of each sample allele size from the corresponding
allelic ladder allele size. All sample alleles are within 0.5 bp of a corresponding allele in
an allelic ladder.

Figure 4 Size deviation of 78 samples analyzed on the 3100 Genetic Analyzer
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5 Experiments and Results
Accuracy, precision, and reproducibility

Precision and size
windows

62

Sizing precision allows for determining accurate and reliable genotypes. Sizing
precision was measured on the 3100 Genetic Analyzer. The recommended method for
genotyping is to use a + 0.5-bp “window” around the size obtained for each allele in
the AmpF(STR® Yfiler® Allelic Ladder. A +0.5-bp window allows for the detection and
correct assignment of alleles. Any sample allele that sizes outside a window could be
either of the following:

* An “off-ladder” allele, for example, an allele of a size that is not represented in the
AmpF(STR® Yfiler® Allelic Ladder

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections in one capillary run. Table 3 on page 62 indicates typical precision results
obtained from the seven injections of the AmpF(STR® Yfiler® Allelic Ladder analyzed
on the 3100 Genetic Analyzer (47-cm capillary and POP-4® polymer). The internal lane
size standard used was GeneScan™ 500 LIZ® Size Standard. These results were
obtained within a set of injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the +0.5-bp
window for a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems having the smallest
standard deviations in sizing. Figure 4 illustrates the tight clustering of allele sizes
obtained on the 3100 Genetic Analyzer, where the standard deviation in sizing is
typically less than 0.15 bp. The instance of a sample allele sizing outside of the +0.5-bp
window because of measurement error is relatively rare when the standard deviation
in sizing is approximately 0.15 bp or less (Smith, 1995).

For sample alleles that do not size within a +0.5-bp window, the PCR product must be
rerun to distinguish between a true off-ladder allele vs. measurement error of a sample
allele that corresponds with an allele in the allelic ladder. Repeat analysis, when
necessary, provides an added level of confidence to the final allele assignment.
GeneMapper® ID Software and GeneMapper® ID-X Software automatically flags
sample alleles that do not size within the prescribed window around an allelic ladder
allele.

It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of parameters, including type and concentration of
polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing
can also be found between runs on the same instrument and between runs on different
instruments because of these parameters. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the AmpF(STR®
Yfiler® Allelic Ladder from the same run and then converted to genotypes. For more
information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield et
al., 1998.

Table 3 Example of precision results of nine injections of the AmpF(STR® Yfiler® Allelic Ladder
run on the 3100 Genetic Analyzer

Allele Mean Standard Deviation

DYS456
13 104.51 0.05
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Chapter 5 Experiments and Results
Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
14 108.31 0.05
15 112.16 0.04
16 116.04 0.04
17 119.90 0.05
18 123.82 0.05
DYS389I
10 142.87 0.04
" 147.28 0.04
12 151.80 0.06
13 156.43 0.07
14 160.66 0.05
15 164.81 0.07
DYS390
18 192.26 0.05
19 195.99 0.04
20 199.93 0.05
21 203.85 0.06
22 207.83 0.05
23 211.90 0.04
24 215.90 0.05
25 219.88 0.06
26 223.84 0.06
27 227.80 0.07
DYS389Il
24 253.05 0.05
25 257.17 0.06
26 261.19 0.07
27 265.38 0.08
28 269.42 0.08
29 273.36 0.06
30 277.63 0.07
31 281.76 0.09
32 285.78 0.07
33 289.93 0.05
34 293.94 0.06
DYS458
14 130.98 0.05
15 134.87 0.06
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5 Experiments and Results
Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
16 138.81 0.03
17 142.95 0.05
18 147.31 0.05
19 151.72 0.05
20 155.94 0.04
DYS19
10 176.06 0.07
" 179.98 0.05
12 183.84 0.05
13 187.76 0.03
14 191.64 0.05
15 195.49 0.05
16 199.32 0.05
17 203.20 0.06
18 207.09 0.07
19 211.02 0.06
DYS385 a/b
7 242.79 0.05
8 246.89 0.07
9 250.94 0.04
10 254.98 0.07
M 259.04 0.08
12 263.08 0.06
13 267.24 0.05
14 271.38 0.06
15 275.47 0.10
16 279.56 0.08
17 283.70 0.07
18 287.79 0.05
19 292.06 0.06
20 296.19 0.07
21 300.42 0.06
22 305.06 0.12
23 309.50 0.07
24 313.99 0.10
25 318.39 0.05
DYS393
8 100.26 0.05
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Chapter 5 Experiments and Results
Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
9 104.19 0.04
10 108.05 0.04
" 112.04 0.04
12 115.98 0.04
13 119.89 0.04
14 123.89 0.04
15 127.80 0.05
16 131.95 0.04
DYS391
7 150.88 0.08
8 155.27 0.06
9 159.67 0.06
10 163.83 0.05
M 167.94 0.07
12 172.00 0.07
13 176.03 0.06
DYS439
8 197.84 0.05
9 201.70 0.03
10 205.68 0.05
" 209.46 0.04
12 213.47 0.03
13 217.41 0.03
14 221.42 0.05
15 225.17 0.04
DYS635 (Y GATA C4)
20 246.43 0.07
21 250.49 0.06
22 254.45 0.06
23 258.49 0.03
24 262.45 0.06
25 266.56 0.06
26 270.56 0.03
DYS392
7 291.38 0.05
8 294.39 0.07
9 297.44 0.06
10 300.30 0.06
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5 Experiments and Results
Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
1" 303.91 0.07
12 307.44 0.07
13 310.64 0.08
14 313.74 0.07
15 317.12 0.1
16 320.45 0.08
17 323.54 0.09
18 326.79 0.10
Y GATA H4
8 122.01 0.06
9 125.98 0.06
10 129.97 0.07
" 134.01 0.04
12 138.09 0.03
13 142.37 0.05
DYS437
13 182.53 0.05
14 186.45 0.07
15 190.40 0.04
16 194.25 0.04
17 198.07 0.03
DY438
8 223.69 0.06
9 228.68 0.06
10 233.63 0.07
1" 238.59 0.06
12 243.63 0.05
13 248.66 0.05
DYS448
17 280.49 0.04
18 286.58 0.03
19 292.70 0.05
20 298.92 0.05
21 305.51 0.04
22 312.25 0.06
23 318.60 0.10
24 324.88 0.08
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Reproducibility

Chapter 5 Experiments and Results

Extra Peaks in the electropherogram

1.2 mm punches from 40 male buccal samples on FTA® paper were amplified for

26 cycles with the Yfiler® Direct Kit on the GeneAmp® PCR System 9700. One sample
yielded a partial profile. All other samples yielded complete profiles with >40%
average intracolor balance in all 4 dye channels.

Figure 5 Intracolor balance for Yfiler® Direct profiles generated from 39 male buccal samples
on FTA® paper.
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1.2 mm punches from the same 40 male buccal samples and 72 male blood samples on
FTA® paper were also amplified using the Yfiler® Direct Kit on the Veriti® Thermal

Cycler. All samples had been previously amplified with Yfiler® Direct on the 9700 and
genotyped. Results generated from amplification on the Veriti® Thermal Cycler were
100% concordant to results previously generated following amplification on the 9700.

Extra Peaks in the electropherogram

Causes of extra
peaks

Stutter products

Peaks other than the target alleles may be detected on the electropherogram displays.
Several causes for the appearance of extra peaks, including the stutter product (at the
n—4 position), incomplete 3" A nucleotide addition (at the n—1 position), artifacts, and
mixed DNA samples.

A stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2001). Sequence analysis of stutter products at tetranucleotide STR loci
has revealed that the stutter product is missing a single tetranucleotide core repeat unit
relative to the main allele (Walsh et al., 1996). It has been reported that the DYS19
tetranucleotide repeat locus displays the typical -4 bp stutter but also a -2 bp stutter
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5 Experiments and Results
Extra Peaks in the electropherogram

Addition of 3" A

68

(Prinz et al., 2001; Gusmao et al., 1999). The DYS392 trinucleotide repeat locus displays
the typical -3 bp stutter but also a smaller +3 bp stutter. Sequence analysis of this +3 bp
stutter revealed that the product contains an additional repeat unit relative to the true
allele peak.

The proportion of the stutter product relative to the main allele (stutter percent) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. The Yfiler® Direct Kit stutter percentages were calculated from data generated
from 86 samples (57 blood samples on FTA® paper and 29 buccal samples on FTA®
paper). The mean stutter percentage plus three standard deviations were calculated for
each locus and compared to the stutter percentages generated previously with the
Yfiler® Kit.

Some of the general conclusions from these measurements and observations are as
follows:

* For each Yfiler® Direct Kit locus, the stutter percentage generally increases with
allele length. Smaller alleles display a lower level of stutter relative to the longer
alleles within each locus.

* Each allele within a locus displays percent stutter that is reproducible.

¢ The stutter value for each locus was determined by taking the mean plus three
times the standard deviation. For all loci these values are lower than the stutter
filter percentages determined using the original Yfiler® Kit. Therefore, the
original Yfiler® Kit stutter values were used during the filtering step in
GeneMapper® ID Software or GeneMapper® ID-X Software. Peaks in the stutter
position that are above the stutter filter percentage will not be filtered. Peaks in
the stutter position that have not been filtered and remain labeled can be further
evaluated.

* The measurement of percent stutter may be unusually high for main peaks that
are off-scale.

Note: The stutter values observed for the Yfiler® Direct Kit were consistent with those
obtained with the Yfiler® Kit. In situations where a global cutoff filter is used, locus-
specific stutter filters will be applied when the stutter percentage exceeds the global
cutoff filter value.

AmpliTaq Gold® enzyme, like many other DNA polymerases, can catalyze the
addition of a single nucleotide (predominately adenosine) to the 3" ends of
double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This non-template
addition results in a PCR product that is one base pair longer than the actual target
sequence, and the PCR product with the extra nucleotide is referred to as the “+A”
form.

The efficiency of “A addition” is related to the particular sequence of the DNA at the 3’
end of the PCR product. For the Yfiler® Direct Kit the primer sequences are optimized
to promote A addition.

Lack of full A nucleotide addition may be observed in Yfiler® Direct Kit results when
the amount of input DNA is greater than recommended protocols. This is because
more time is needed for AmpliTag Gold® DNA Polymerase to add the A nucleotide to
all molecules as more PCR product is generated. Amplification of too much input
DNA will also result in off-scale data.
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Artifacts

Chapter 5 Experiments and Results
Characterization of loci

Developmental validation studies for the Yfiler® Kit were performed using a 10%
global cut-off value which provides effective filtering of low-level artifacts and
streamlines the analysis of single source samples. If a global cut-off value is not used
low-level artifacts, or anomalies may be observed above the detection threshold.

Figure 6 demonstrates reproducible artifacts while using the Yfiler® Direct Kit.

Consider these artifacts when interpreting data.

Figure 6 Examples of baseline noise and reproducible artifacts in data produced on the 3130x!
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Genotyping may result in the detection of these
Alleles”.

artifacts as off-ladder alleles, or “OL

Note: A high degree of magnification (y-axis) is used in this figure to illustrate these
artifacts (data produced on capillary electrophoresis instrument platforms).

Characterization of loci

SWGDAM Guideline
2.1

Nature of the
polymorphisms

“The basic characteristics of a genetic marker must be determined and documented.”

(SWGDAM, July 2003).

This section describes basic characteristics of the 17 loci that are amplified with the
Yfiler® Direct Kit. These loci have been extensively characterized by other laboratories
(Gusmao et al., 1999; Butler et al., 2002; Gonzalez-Neira et al., 2001; Hall and
Ballantyne, 2003; Redd et al., 2002; Schoske et al., 2004).

DYS392 is a trinucleotide repeat, DYS438 is a pentanucleotide repeat, and DYS448 is a
hexanucleotide repeat. Their allele differences result from differences in the number of
repeat units 3-bp, 5-bp and 6-bp respectively. The remaining Yfiler® Direct Kit loci are
tetranucleotide short tandem repeat (STR) loci. The length differences among alleles of
these particular loci result from differences in the number of 4-bp repeat units.

AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide

69

@)
1)
<
o
o
ke
3
o
>
=
D
&
=
=
o
=)




5 Experiments and Results
Characterization of loci

Inheritance

Mapping

70

We have sequenced all the alleles in the AmpF/(STR® Yfiler® Allelic Ladder. In
addition, other groups in the scientific community have sequenced alleles at some of
these loci (Redd et al., 2002; www.cstl.nist.gov/biotech/strbase/y_strs.htm ). Among
the various sources of sequence data on the Yfiler® Direct Kit loci, there is consensus
on the repeat patterns and structure of the STRs.

The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from

39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Three CEPH family DNA sets were examined. 1 ng of DNA from each sample was
amplified using the Yfiler® Kit and the Identifiler® Kit, followed by analysis using a
3100 Genetic analyzer. The families examined included #1333 (9 offspring, 7 males),
#1340 (7 offspring, 5 males), and #1345 (7 offspring, 5 males), representing 23 meiotic
divisions. The Identifiler® Kit results confirmed that the loci are inherited according to
Mendelian rules, as has been reported in the literature (Nakahori et al., 1991; Edwards
etal.,, 1992; Kimpton et al., 1992; Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993;
Straub et al., 1993). The Yfiler® Kit results confirmed that the loci were inherited
according to a Y-linked (father to son) transmission. In no case was the maternal
grandfather’s Y-haplotype found in the offspring. In family #1345, one son (1345-7356)
had a DYS458-18 allele while the rest of his male relatives had a DYS458-17 allele. In
family #1340 one son (1340-7342) had a DYS458-16 allele while the rest of his male
relatives had DYS458-17. Calculation of a mutation rate based on this small population
size would be inaccurate due to the small sample size. The samples were reamplified
and reinjected to confirm the allele call.

The Yfiler® Direct Kit loci have been mapped and the chromosomal location on the
Y-chromosome is known based on the nucleotide sequence of the Y-chromosome. The
Genbank accession numbers for representative sequences are: DYS19 (X77751,
AC017019), DYS385 (AC022486, Z93950), DYS389 (AC011289, AF140635), DYS390
(AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393
(G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992),
DYS448 (AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676,
AC011751) and Y GATA C4 (G42673).
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Chapter 5 Experiments and Results

Species specificity

Species specificity
SWGDAM Guideline  “For techniques designed to type human DNA, the potential to detect DNA from forensically
2.2 relevant nonhuman species should be evaluated.” (SWGDAM, July 2003).
The Yfiler® Direct Kit provides the required degree of specificity specific to primates.
Other species do not amplify for the loci tested.
Nonhuman Studies

The Yfiler® Direct Kit provides the required degree of specificity for the species tested
(Figure 7 on page 72).

The following experiments were conducted to investigate interpretation of Yfiler®
Direct Kit results from nonhuman DNA sources.
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The extracted DNA samples were amplified in Yfiler® Direct Kit reactions and
analyzed using the 3130x! Genetic Analyzer.

Non-primates — Dog, pig, cat, horse, and chicken (10 ng each).

Microorganisms — Candida albicans, Neisseria gonorrhoeae, Escherichia coli 0157:H7,
Bacillus subtilis, Staphylococcus aureus, and Lactobacillus rhamnosus (10 ng total from a
pool of these microorganisms).

The non-human species tested did not yield reproducible, detectable results.
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Species specificity

Figure 7 Representative electropherograms from a species specificity study, including positive
and negative controls.
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Sensitivity

Sensitivity

SWGDAM Guideline “When appropriate, the range of DNA quantities able to produce reliable typing results should

2.3 be determined.” (SWGDAM, July 2003).

Blood on FTA® The Yfiler® Direct Kit has been optimized at 25 uL PCR reaction volume to overcome

cards or Copan® the PCR inhibition expected when amplifying blood samples directly from unpurified o

NUCLEIC-CARD™ 1.2 mm FTA® or Copan® NUCLEIC-CARD™ discs. Depending on the volume of blood %
spotted onto the FTA® card, DNA quantities present on the 1.2 mm disc may vary o

system between laboratories. It is essential for your laboratory to optimize the PCR conditions 3
based on the types of blood samples received or based on your standard operating 3
protocol used in the spotting of blood onto FTA® cards or Copan® NUCLEIC-CARD™ %
system. Refer to page 17 for instructions on PCR optimization. %

!
Buccal cells on The Yfiler® Direct Kit has been optimized at 25 pL PCR reaction volume to overcome E
FTA® cards or the PCR inhibition expected when amplifying buccal cells directly from unpurified

Copan® NUCLEIC- 1.2 mm FTA® or Copan® NUCLEIC-CARD™ discs. Depending on the collecting

™ devices used, the collection methods applied, and the swab-to-treated paper transfer
CARD™ system protocol employed, DNA quantities present on the 1.2 mm disc may vary between
samples and different laboratories. It is essential for your laboratory to optimize the
PCR conditions based on the types of buccal samples received or based on your
standard operating protocol used in transferring saliva from a buccal swab onto an
FTA® card or Copan® NUCLEIC-CARD™ system. Refer to page 17 for instructions on
PCR optimization.

Effect of DNA If excessive DNA is added to the PCR reaction, then the increased amount of PCR
quantity on results product that is generated can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).
Off-scale data is problematic for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

¢ Incomplete A nucleotide addition.

To ensure minimal occurrence of offscale data when using the Yfiler® Direct Kit,
optimize PCR cycle number according to instructions on page 17.
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Experiments and Results

Figure 8 Average Yfiler® Direct peak height/sample for buccal samples from 1.2 mm FTA
punches and DNA Control 007. 4 ng 007 DNA was amplified for 27 cycles, 6 ng of 007 DNA was

amplified for 25 and 26 cycles with Yfiler® Direct.
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Population data

SWGDAM Guideline
2.7

Overview
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“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

To interpret the significance of a match between genetically typed samples, it is
necessary to know the population distribution of alleles at each locus in question. If the
genotype of the relevant evidence sample is different from the genotype of the
suspect’s reference sample, then the suspect is “excluded” as the donor of the
biological evidence tested. An exclusion is independent of the frequency of the two
genotypes in the population.

If the suspect and evidence samples have the same genotype, then the suspect is
“included” as a possible source of the evidence sample. The probability that another,
unrelated, individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).

AmpFtSTR® Yfiler® Direct PCR Amplification Kit User Guide



Chapter 5 Experiments and Results

Population data

Population The Yfiler® Kit was used to generate the population data provided in this section.
samples used in Samples were collected from individuals throughout the United States with no
these studies geographical preference.
Population Number of samples
African-American 333
U.S. Caucasian 254
o
U.S. Hispanic 175 %
o
E
Gene diversity Table 4 shows the Yfiler® Kit gene diversity in three populations, listed as e
values percentages. 5y
<
Table 4 Yfiler® Kit Gene Diversity values across three different U.S. populations %
2
Locus African-American U.S. Caucasian U.S. Hispanic S
(n=333) (n = 254) (n=175)
DYS458 0.755 0.808 0.77
DYS19 0.748 0.541 ' 0.645
DYS385a/b 0.951 0.855 0.931
DYS393 0.619 0.412 0.507
DYS391 0.423 0.54 0.52
DYS439 0.629 0.663 ' 0.665
DYSé635 0.701 0.682 0.71
DYS392 0.419 0.615 0.671
Y GATA H4 0.599 0.604 0.575
DYS437 0.495 0.624 ' 0.583
DYS438 0.528 0.622 0.712
DYS448 0.685 0.651 0.726

2
Gene diversity (D) = 86l =20} wheren = sample size, p; = allele frequency
(Johnson et al., 2003). "~ !

Analyzing the In addition to the alleles that were observed and recorded in the Life Technologies

population data databases, other known alleles have been published or reported to us by other
laboratories. Some of these alleles occur at a low frequency and include several
microvariants (Furedi et al., 1999; Schoske et al., 2004).

Discriminatory capacity of haplotypes

Table 5 shows the discriminatory capacity (DC) and the number of unique haplotypes
(UH) for each Y-STR marker combination listed. The discriminatory capacity was
determined by dividing the number of different haplotypes by the number of samples
in that population (Schoske et al., 2004). A unique haplotype is defined as one that
occurs only once in a given population. The number of unique haplotypes is usually
less than the number of different haplotypes in any given population.
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Table 5 Discriminatory capacity and number of unique haplotypes for three U.S. populations

African-American U.S. Caucasian U.S. Hispanic
Y-STR marker (N=333) (N=254) (N=175)
combination
DC (%) UH DC (%) UH DC (%) UH
Minimal 84.6 249 74.8 162 85.1 136
haplotype™
U.S. haplotypet 91.3 286 83.8 196 90.3 146
US.haplotype+ 919 286 858 202 | 914 148
DYS437
Yfiler haplotype 99.1 327 98.8 248 98.3 169
t The minimal haplotype includes the markers DYS19, DYS385 a/b, DYS389 I/11, DYS390, DYS391, DYS392,
DYS393.

I The U.S. haplotype includes the minimal haplotype loci plus DYS438 and DYS439.

Mutation rate

Estimation of spontaneous or induced germline mutation at genetic loci may be
achieved through comparison of the genotypes of offspring to those of their parents.
From such comparisons the number of observed mutations are counted directly.

In previous studies, haplotypes of eight loci amplified by the Yfiler® Kit were
determined for a total of 4999 parent-son (Kayser and Sajantila, 2001). Fourteen
mutations were identified and an overall average mutation rate was estimated at
2.80 x 10°3. In two confirmed father/son pairs mutation at two Y-STRs were observed.

Additional studies need to be performed for other loci in order to estimate their
average mutation rate.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that can

occur during analysis.

Table 6 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR®
Control DNA 007 and the
DNA test samples at all
loci

Incorrect volume or absence of PCR
Master Mix or Yfiler® Direct Primer
Set

Repeat amplification.

No activation of AmpliTaq Gold® DNA
Polymerase

Master Mix not vortexed thoroughly
before aliquoting

Repeat amplification, and hold reactions initially at
95°C for 1 minute.

" Vortex the Master Mix thoroughly.

Yfiler® Direct Primer Set exposed to
too much light

Store the Primer Set protected from light.

GeneAmp® PCR System malfunction

Use of incorrect thermal cycling
parameters

Refer to the thermal cycler user’s manual and
check instrument calibration.

' Check the protocol for correct thermal cycling

parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
9700

Use MicroAmp® Reaction Tubes with Caps for the
GeneAmp® PCR System 9700.

Remove MicroAmp® Base from tray/retainer set

and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Perform Electrophoresis” on page 23.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di"" Formamide.

Positive signal from
AmpF(STR® Control
DNA 007 but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Repeat test with another punch sample.

Test sample DNA is severely
degraded or of insufficient quantity

Repeat test with another punch sample.

More than one allele
present at a locus
(except for DYS385a/b)

Presence of exogenous DNA

Amplification of stutter product

Mixed sample

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

" See “Stutter products” on page 67.
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Troubleshooting

Observation

Possible causes

Recommended actions

Some but not all loci
visible on
electropherogram of
DNA test samples

Test-sample DNA is severely
degraded or of insufficient quantity

Repeat test with another punch sample.

Poor peak height
balance

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

GeneAmp® PCR System 9700 with
Aluminum 96-Well block or third
party thermal cyclers

Use GeneAmp® PCR System 9700 with silver or
gold-plated silver blocks only, or the Veriti® 96-
Well Thermal Cycler.

78
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Equipment and materials not included

Ordering Information

Table 7 and Table 8 list required and optional equipment and materials not supplied
with the Yfiler® Direct Kit. Unless otherwise noted, many of the items are available

from major laboratory suppliers (MLS).

Table 7 Equipment

Equipment

Source

3100/3100-Avant Genetic Analyzer

Applied Biosystems® 3130/3130x( Genetic Analyzer

Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems® 310 Genetic Analyzer

Contact your local
Life Technologies
sales representative

GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the gold-plated silver 96-well block 4314878
Veriti® 96-Well Thermal Cycler 4375786
Silver 96-well sample block N8050251
Gold-plated silver 96-well sample block 4314443
Tabletop centrifuge with 96-well plate adapters (optional MLS

Harris Manual Punch, 1.2 mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a 1.2 mm punch head
BSD1000-GenePunch Automated Dried Sample Punch Instrument with a 1.2 mm punch head

Contact your local
Life Technologies
support representative
for information.

Bode Buccal DNA Collector™

Copan® NUCLEIC-CARD™

4467893

This number is not
available for sale in
the US.

Contact your local

Life Technologies
support representative
for information.

This product is not
available for sale in
the US.
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Table 8 User-supplied materials

Item? Source
AmpF(STR® Yfiler® Direct PCR Amplification Kit 4427368
Prep-n-Go™ Buffer 4467079
3100 Analyzer materials
96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
Hi-Di™ Formamide 4311320
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
250-pL glass syringe (array-fill syringe) 4304470
5.0-mL glass syringe (polymer-reserve syringe) 628-3731

For a complete list of s and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3700 Genetic
Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub. no. 4335393).

3130x! Analyzer materials

96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of s and accessories for the 3130/3130x( instrument, refer to Appendix A of the Applied Biosystems®
3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 4352716).

3500/3500xL Analyzer materials
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
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Item? Source
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems® 3500/3500xL

Genetic Analyzer User Guide (Pub. no. 4401661)
PCR Amplification

MicroAmp® 96-well tray N8010541
MicroAmp® reaction tube with cap, 0.2-mL N8010540
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 8-cap strip N8010535
MicroAmp® 96-well tray/retainer set 403081
MicroAmp® 96-well base N8010531
MicroAmp® clear adhesive film 4306311
MicroAmp® optical adhesive film 4311971
MicroAmp® optical 96-well reaction plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 05 M MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any

chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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PCR Work Areas

Work area setup and labdesign............. ... 83
PCRsetupworkarea.............ooiiiiiiiiii i 83
Amplified DNA workarea ... 84

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using the AmpF(STR® Yfiler® Direct PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998)

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the DO NOT USE (and other PCR-based tests) enables amplification
of minute quantities of DNA, necessitating precautions to avoid contamination of
samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR setup work area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes (1.5-mL or 2.0-mL) or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors
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Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The DO NOT USE is not validated for use with the GeneAmp® PCR
System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling
platform may adversely affect performance of the DO NOT USE.

e Veriti® 96-Well Thermal Cycler
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety
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WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the icular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

CAS

Chemical Phrase

26628-22-8 | Sodium Azide Sodium azide may react with lead and copper

plumbing to form highly explosive metal azides.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

@ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Dement of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

* Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

Document title Pub. no.
3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834
3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFISTR® PCR Amplification Kit PCR Products 4332345
User Bulletin

Applied Biosystems® 3130/3100xl Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems® 3130/3130x! Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems® 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems® 3130/3130xl Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems® 3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems® 3130/3100xl DNA Analyzers User Guide 4331468
Applied Biosystems® 3500/3500xL. Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661
Applied Biosystems® 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Applied Biosystems® 3730/3730x| Genetic Analyzer Getting Started Guide 4359476
GeneAmp® PCR System 9700 Base Module User’s Manual N805-0200
Veriti® 96-Well Thermal Cycler AmpFISTR®Kit Validation User Bulletin 4440754
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human Male DNA 4344790
Quantification Kit User's Manual

PrepFiler® Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper® ID Software v3.2 User Bulletin 4352543
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Getting Started Guide 4396773
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Quick Reference Guide 4402094
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Documentation and Support
Obtaining SDSs

Document title Pub. no.
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482

Portable document format (PDF) versions of this guide and the documents listed above
are available at www.lifetechnologies.com.

Note: To open the user documentation available from the our web site, use the Adobe®
Acrobat® Reader® software available from www.adobe.com.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

Obtaining Certificates of Analysis

The Certificate of Analysis provides detailed quality control and product qualification
information for each product. Certificates of Analysis are available on our website. Go
to www.lifetechnologies.com/support and search for the Certificate of Analysis by
product lot number, which is printed on the box.

Obtain support

For HID support:

¢ In North America — Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

¢ Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

¢ Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

* Obtain information about customer training

e Download software updates and patches

90 AmpFISTR® Yfiler® Direct PCR Amplification Kit User Guide


http://www.lifetechnologies.com/support
http://www.lifetechnologies.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com/support
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.lifetechnologies.com
http://www.appliedbiosystems.com
http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
http://www.appliedbiosystems.com/support
http://www.lifetechnologies.com/support
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
http://www.lifetechnologies.com/support
http://www.lifetechnologies.com/support

Documentation and Support
Limited Product Warranty

Limited Product Warranty

Life Technologies and/or its affiliate(s) warrant their products as set forth in the Life
Technologies' General Terms and Conditions of Sale found on Life Technologies’
website at www.lifetechnologies.com/termsandconditions. If you have any questions,
please contact Life Technologies at www.lifetechnologies.com/support.
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